
 

Customer Release Notes

Fiery EX12 Color Server, version 2.0 SP2
for Xerox DocuColor 12 Digital Copier/Printers

                         
This document contains information about Fiery EX12 Color Server™ server software 
version 2.0 SP2. Before using the Fiery EX12 Color Server with version 2.0 SP2, make 
a copy of these Customer Release Notes and distribute them to all users.

Before printing to the Fiery EX12:

• Verify that system software version 2.0 SP2 is installed on the Fiery EX12.

• Install user software onto client computers. For instructions, see the 
User Software Installation Guide.

This document uses the term “Fiery EX12” to refer to the Fiery EX12 Color Server.

NOTE: This product supports Windows 9x/ME, Windows NT 4.0 Service Packs 4, 5, 
and 6, Windows 2000 Service Pack 2, and Windows XP. 

Installing Microsoft hotfixes

In this version, if you have the Fiery Advanced Controller Interface (FACI) installed, you 
are permitted to download and install critical hotfixes from the Microsoft web site to the 
Fiery EX12. Your browser’s security settings must enable Active X to install these hotfixes.

NOTE: If you do not have the FACI installed, you can obtain hotfixes in software updates 
downloaded from EFI.

Accessing Fiery software updates through WebTools

Fiery WebTools now displays a link that allows remote users to access software updates.
To use this link:

1. Start your Internet browser.

2. Enter the IP address or DNS name of the Fiery EX12 and press Enter.

The Fiery EX12 home page appears.

3. Click the Check for product updates link.

4. Follow online instructions to download software updates for the Fiery EX12.

New features
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Windows NT hotfixes in this version

This version incorporates the following Microsoft hot fixes for Windows NT 4.0:

Installing on Windows 2000 computers

Before you install Fiery EX12 software on Windows 2000 computers, make sure you have 
Service Pack 2 installed. Install Service Pack 2 from the Microsoft Web site. You can follow 
the link on the User Software CD in the SP2 folder to the Service Pack 2 download page. 

Follow the instructions on the LCD only. Do not press or touch anything during the 
installation process. Wait for the server prompt before inserting CD3.

You can delete the client PC driver using Fiery Printer Delete Utilities. For further details, 
see the software information guide.

Installing on Windows 95 computers

Command Workstation 4 requires Windows Socket 2, which is not included in 
Windows 95 operating systems. Download Windows Socket 2 from the Microsoft 
website at www. microsoft.com and install before you install Command Workstation 4 
on Windows 95. 

MS99-046 (Q243835) MS00-079 (Q304158i) 

MS99-047 (Q243649) MS00-091 (Q275567) 

MS99-055 (Q246045) MS00-094 (Q276575) 

MS99-056 (Q248183) MS00-095 (Q265714)

MS99-057 (Q248183) MS01-003 (Q279336) 

MS00-003 (Q247869) MS01-008 (Q280119) 

MS00-004 (Q249108) MS01-009 (Q283001) 

MS00-005 (Q249973) MS01-048 (Q305399i) 

MS00-008 (Q259496) MS02-008 (Q317244) 

MS00-021 (Q257870) MS02-014 (Q313829i) 

MS00-024 (Q259496i) MS02-017 (Q312895i) 

MS00-027 (Q259622i) MS02-024 (Q320206i) 

MS00-029 (Q259728) MS02-029 (Q318138i) 

MS00-036 (Q262694) MS02-045 (Q326830i) 

MS00-040 (Q264684) MS02-048 (Q323172) 

MS00-047 (Q269239) MS02-050 (Q329115) 

MS00-052 (Q269049) MS02-071 (Q328310) 

MS00-063 (Q271652) MS03-001 (Q810833)

MS00-070 (Q266433) 

Windows NT 
hotfixes

Installation
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Installing Command WorkStation

When you install Command WorkStation version 4.1.0.37, an error message may appear 
that recommends that you upgrade from Internet Explorer 5 to Internet Explorer 6.  The 
Fiery EX12 version 2.0 SP2 update includes Internet Explorer 5.  We recommend that you 
upgrade to the latest version of Internet Explorer, which is available on the Microsoft web 
site.

Fiery EX12 Password

The Windows NT system password for the Fiery EX12 is no longer blank. It has been set 
initially to Fiery.1 Change this password immediately after you install and configure your 
Fiery EX12. 

To change the Fiery EX12 Windows NT password from Windows NT 4.0/2000/XP 
clients: 

1. Log in as Administrator and press CTRL+ALT+DELETE to display the Windows NT 
Security window.

2. Click Change Password and specify all of the following information:

User Name: Administrator

Domain: IP address or Server Name of the Fiery

Old Password: Fiery.1 or current password

New Password: Enter new password. Passwords must be at least six characters long and 
must include uppercase letters (A - Z), lowercase letters (a - z), numbers (0 - 9), and 
non-alphanumeric characters (., !, ?, #, &, etc.).

Confirm New Password: Re-enter your new password.

3. Click OK.

For more information on changing the system password, see the Configuration Guide.

Configuration Page

The Configuration page lists the number of copies made when the Fiery EX12 was last 
started. To update the number, restart the Fiery EX12. 

Renaming the Fiery EX12

If you rename the Fiery EX12, the name must be fewer than 10 characters. 

Administrator login

To run Setup from the Fiery EX12 Control Panel, you must log in with 
Administrator privileges.

Clear Server

Clear all server queues by using the Clear Server button in the Setup menu available 
through Command WorkStation. Clearing server queues restarts the system.

Local Setup from a Windows computer

If a connection to the Fiery EX12 fails after you change settings in the General or Printer 
Setup tab of the Fiery Server Setup dialog box, the Work Group name and Domain name 
may be the same. To resolve this problem, assign different names.

Setup
XC 701P41810 (EFI Part Number: 45042719)



 

Page 4

                                 
Character limitation in Network Setup

In Network Setup from the Fiery EX12 Control Panel, you can enter a maximum of 
32 characters for the context name. When using Fiery Setup™ or Fiery WebSetup™, you 
can enter more than 32 characters.

Remote Setup for Bindery and NDS

When configuring Bindery or NDS in Network Setup using WebSetup or EFI Command 
WorkStation™ from a client computer, enter a password in order to make changes. For 
Bindery Setup, log in as Admin, Supervisor, or Guest, with the appropriate password. 
For NDS, select the appropriate login and password.

WebSetup

During Bindery Setup, WebSetup only allows you to choose “Admin,” “Supervisor,” or 
“Guest.” It does not allow you to enter a unique user name. If these accounts have been 
renamed on your system, use local setup. 

IPX Auto Frame Type

If you enable IPX Auto Frame Type in Setup, the Fiery EX12 will bind only to the first 
frame type it finds, which is typically 802.2 or Ethernet II. To ensure that all available frame 
types are bound, select each one individually. After the Fiery restarts upon exiting Setup, 
print the Configuration page to verify that all selected frame types were successfully bound.

Point and Print Drivers

In Setup from the Fiery EX12 Control Panel, the Point and Print Drivers option follows 
the Use Automatic Configuration option. The sequence of these options is incorrect in the 
Configuration Guide.

Point and Print on Windows2000/XP computers

Point and Print (PnP) printing is not supported from Windows2000/XP computers. 
Printer drivers should be installed from the User Software CD or WebTools™. 
For information on installing these drivers, see Chapter 1 of the User Software 
Installation Guide.

WINS Address

The WINS Address will not appear in WebSetup in DHCP mode when configuring the 
Network Setup. Print a Configuration page to see the WINS address. 

Fiery color calibration

DTP34 and the EFI Spectrometer™ (ES-1000) are not supported for the Fiery EX12. 

Creating an SMB port in Windows 2000/XP

To create an SMB port in Windows 2000/XP, you must first establish a connection to the 
server with an IP address. Do this by choosing Start and then selecting Run. At the prompt, 
enter “\\” followed by the server IP address, and then click OK. After you make the 
connection, you can follow the instructions to create an SMB port on Windows 2000/XP. 
XC 701P41810 (EFI Part Number: 45042719)
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Restore Backup

The Windows NT OS Workstation software resides on the hard disk and is backed up the 
first time you turn on the Fiery EX12. If necessary, you can retrieve a backup of the 
software using the Fiery Restore/Update CD. Insert the CD in the CD drive, and restart 
the Fiery EX12. After restoring, you will need to reinstall any features and utilities you have 
installed from the User Software CD and the User Documentation CD.

Fiery EX12 passwords 

The Fiery EX12 password used to access Setup, as well as the password required to log in to 
the Fiery EX12, are case sensitive and must be entered exactly.

Maximum number of users for SMB

Windows NT 4.0 supports a total of 10 SMB simultaneous connections, including the 
Direct connection, Print queue, and Hold queue.

Windows 2000 and LPR availability

When you perform a fresh install of Windows 2000 on a client computer, no LPR services 
are available by default. Your only option is to print through a standard TCP/IP port or use 
SMB printing. However, if you converted a Windows NT 4.0 computer to Windows 2000, 
LPR printing services are retained.

Fiery EX12 domain configuration

To add the Fiery EX12 to a domain in configurations that do not include the Fiery 
Advanced Controller Interface (FACI) option, you must add the Fiery EX12 from another 
Windows NT 4.0 server on the network, using the Server Manager utility.

Tray Alignment

Tray Alignment is not an option that can be set from the Fiery LCD display. Use 
Command Workstation to set the Tray Alignment option.

Diagnostics

E-mail must be set to “on” to test the machine diagnostics. If E-mail is switched to “off ”, 
the LCD will remain blank when you run diagnostics.

Startup error—driver failed

You may see the following message on the monitor when you restart the system: “At least 
one service or driver failed during system startup. Use Event Viewer to examine the event 
log for details.” Ignore the message and click OK to close the window. 

Memory configuration

The total memory is 256MB. The server monitor during startup displays 120MB. 
The Command Workstation memory usage bar displays 136MB.

Command WorkStation connection lost

If the message “Connection to the Fiery EX12 lost” appears in the Command WorkStation 
window, click OK and then restart the Fiery EX12 using Reboot System from the Server 
menu on the Control Panel. You can then start Command WorkStation to re-establish 
the connection.

System

LCD

Fiery Advanced 
Controller Interface 
(FACI)
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Disk full error message

When the hard disk on the Fiery EX12 is full, print jobs sent to the Fiery EX12 are not 
printed until the current job is finished. You can remove completed jobs from the Printed 
Queue to free up disk space.

PDF files

PDF files sent to the Direct connection are treated as if they were sent to the Print queue.

When using Downloader to download PDF files, the file name and user name appear 
as “Unknown.”

When you print a PDF file with auto tray selection, if the job is collated it may go to the 
stacker instead of the Simple Catch Tray (SCT).

Two-sided (duplex) printing

Two-sided printing may be enabled only on FACI systems.

Multi-page, mailbox jobs

When printing a multi-page job to a mailbox, the job will print in forward, face-up order, 
so that pages are reversed on completion. To print the job in normal page order, print 
mailbox jobs with page order reversed.

IPP printer properties

IPP printer properties displays all jobs in the Fiery EX12 Hold queue, regardless of where 
the jobs were sent. 

DNS Names

DNS Names cannot be used for E-mail printing unless your system is configured to use 
DHCP and the Fiery Advanced Controller Interface (FACI) option. Otherwise, use the 
Fiery EX12 IP address for E-mail printing. 

E-mail account password

E-mail printing does not work if the Fiery e-mail account does not have a password. Set a 
password for the e-mail account the Fiery EX12 is configured to use to enable it to receive 
e-mail print jobs. 

Slipsheet paper source

When you select the slipsheet paper source, Tray 5 is not available to select in the printer 
driver. Tray 5 does not support slipsheets.

Output destination

The Output destination finishing options SCT and OCT print to a single location, but 
output may differ depending on which tray is installed. To determine output capability, 
check your printer to see if the simple catch tray or offset catch tray is installed. 

Multi-page, mailbox jobs

When printing a multi-page job to a mailbox, the job will print in forward, face-up order, 
so that pages are reversed on completion. To print the job in normal page order, print 
mailbox jobs with page order reversed.

Printing

E-mail printing

Finishing
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Mailbox and collation features

Jobs sent to the mailbox may not be collated.

Autoselect output trays

When autoswitching is disabled from the DC12 or client for an output tray, the tray will 
still be autoselected for output when the primary tray is empty.

Entering IP addresses

In the Printer Properties dialog box, pressing Enter after entering an IP address closes the 
dialog box. Use Tab or the mouse to move between fields and fill in all options before 
pressing Enter or clicking OK. 

Paper size

When sending a job from an application such as Microsoft Word that allows you to specify 
paper size in the Print dialog box, be sure to select the same paper size in both the 
application’s Page Setup dialog box and the printer’s Properties dialog box.

Before printing your job, verify that the paper size selection in Document Setup and 
Page Setup are the same. This will resolve problems with your output, such as image 
clipping and unintentional scaling.

Negative Image

The Negative Image print option does not function correctly for color jobs or text. For 
grayscale or black-and-white images, you must set the Black Overprint and Pure Black Text 
and Graphics options to Off in order for the Negative Image option to function.

NOTE: The Negative Image option under Layout is not available for 
Windows NT 4.0/2000/XP. The Adobe PostScript Printer Driver does not support it.

Page Range

You cannot access the Page Range option from the printer driver. Use the application page 
range option or change the setting for this option from Command WorkStation, Fiery 
Spooler, or Fiery WebSpooler.

Cover Page

Selecting the Cover Page option in the printer driver may produce unexpected results and 
prevent the Duplex and Mailbox options from functioning correctly. If a cover page is 
required on Mac 9.x and X Classic systems, use the server cover page. 

Custom Page Size

When you specify a custom page size in the printer driver for Windows 95/98, make sure 
the custom size matches the page size specified in your application. If the page sizes do not 
match, the custom page size may not print correctly.

The Fiery EX12 does not support mixed paper size jobs that contain a custom page size.

Watermarks

Watermarks are not available in the Fiery PPD on Windows NT, XP, or 2000 platforms.

Watermarks are located under page setup for Macintosh 9.1 and X Classic platforms.

Printer properties

Job settings
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Stapler Mode

If Stapler Mode is set to Front, Rear, or Dual, the Face-Down Printing option must also be 
set to On.

Collate

To collate print output, use the Collate option in the Fiery printer driver instead of 
specifying the Collate option within the application.

NOTE: When using the Adobe FrameMaker application, you must select both the Collate 
option within the application and the Fiery Collate option.

Tray Alignment

Tray Alignment is not an option that can be set from the Fiery LCD display. 
Use Command Workstation to set the Tray Alignment option.

Tray 5 does not work in conjunction with the Tray Alignment feature.

Paper tray alignment is less consistent when using smaller size media, such as B-5.

Downloading fonts

Before downloading fonts, turn off Member Printing. 

Printing the Euro currency symbol

The Fiery EX12 supports the following PostScript fonts for printing the Euro currency 
symbol: Courier, Times Roman, Helvetica, and Arial.

Print Page Border

The Print Page Border option under Layout is not available for Windows NT 4.0. 
The Adobe PostScript Printer Driver for Windows NT 4.0 does not support it.

Printer image

The printer image in the printer driver will not display properly if viewed in 24-bit 
screen resolution. To display the image properly, change the screen setting to 16-bit or 
32-bit resolution. 

PDF 1.4 not supported

PDF 1.4 (from Adobe Acrobat Distiller 5.0) is not supported on the Fiery EX12. 

Device name

When you connect to the Fiery EX12, make sure the device name is DC12 (case-sensitive) 
and not DocuColor.

Nickname

You cannot change the nickname after you have added the Fiery EX12 to the list of 
available servers. To use a new nickname, delete the Fiery EX12 from the list of available 
servers and then re-add it with the new nickname.

Downloading jobs

Avoid downloading jobs from a CD ROM or Zip cartridge while the Fiery EX12 
is printing.

Fonts

Printer driver

PDF

Fiery utilities

Fiery Downloader
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Drag and Drop

When you use the drag-and-drop method to print a file, Fiery Downloader™ functions 
slightly differently on the Mac OS than it does on Windows 95/98. On the Mac OS, when 
a file is dropped on the Downloader icon, the Status window appears and remains 
displayed, even after the file prints. On Windows, the Status window appears and then 
closes when the job finishes printing.

PDF files sent to the Direct connection are treated as if they were sent to the Print queue.

NOTE: Direct Connection from removable media (Zip and CD drives) is not supported. 
You will receive an error message if you are connected via client workstation and you access 
the Zip or CD-ROM drive on the server. The direct queue is supported when using the 
FACI and downloading from the Zip or CD-ROM drive.

Adding files

If an error occurs when adding a file to the download list, try the following remedies:

• Make sure the file is closed. A file that is open for viewing cannot be added to the 
download list.

• If you are using Windows, start Windows Explorer and choose Folder Options from the 
View menu. Click the View tab, and deselect “Hide file extensions for known file types.”

File Formats

Using Fiery Downloader to download any format other than EPS, PDF or PS to the Fiery 
EX12 is not supported. 

Downloading PDF files with mixed page sizes or orientations

When you download PDF files that contain more than one page size or orientation, the file 
may not print correctly. To print the file, open it in Adobe Acrobat and print using the 
printer driver.

Downloading EPS files

To download EPS files, you must check Show EPS Files. When saving the file, you must 
choose None for preview instead of the TIFF default. 

Downloading 16-bit TIFF Files

Fiery Downloader is unable to download 16-bit TIFF files to the Fiery.

Exiting WebTools 

Closing the window for an individual WebTool does not exit the browser. Close the 
WebTool window and the browser in order to completely exit WebTools.

Job processing time

The job processing time displayed from Fiery WebSpooler is different from the actual time 
to process the job. 

WebDownloader

When you browse files from WebDownloader™, the default file name extension is “.html”. 
WebDownloader does not determine the default file type or the file type listed in the File 
dialog box. The default file type is predefined by your Internet browser. However, if you 

Fiery WebTools
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send HTML files to the printer, the data is printed as ASCII text (the default extension for 
ASCII text is .txt). Select All Files from the Files of type menu to view other files 
to download.

PDF files sent to the Direct connection are treated as if they were sent to the Print queue.

When you download PDF files or TIFF images, WebDownloader does not always display 
thumbnails for RIPped jobs. Therefore, you cannot determine whether the job has been 
RIPped. To avoid this problem, use Fiery Downloader.

When downloading PDF files from a Windows computer, the file name and user name are 
displayed as “Unknown.”

WebScan

If you use WebScan™ to download a multiple-page document in TIFF or JPEG format, 
you will be able to view only the first page of the document in most image-editing 
applications. To view the entire document in the image-editing application, scan and 
download each page (and side, if duplex) of the document as a separate file.

If an error occurs when opening a downloaded TIFF document in Adobe Photoshop, the 
document may have been downloaded with a .tiff extension in its file name. To open the 
document in Photoshop, first change the file extension to .tif. 

WebSetup 

If you are unable to access WebSetup™ by entering the DNS name of the Fiery EX12 in 
Internet Explorer, perform the following steps:

1. Start WebSetup by entering the IP address of the Fiery EX12 in Internet Explorer.

The Accessing WebSetup window appears, displaying instructions for configuring 
Internet Explorer.

2. Follow the instructions displayed in the window. If the Java Custom Settings button is 
not visible, scroll to the Microsoft VM area of the Custom Level dialog box, and select 
Custom under Java Permissions.

3. Repeat the instructions, but select the Local Intranet zone in step 3 instead of 
Internet. Configure the Local Intranet options using the same settings that were used 
for the Internet zone.

WebSpooler 

If you are unable to start WebSpooler™ from a Mac OS computer using Internet Explorer, 
perform the following steps:

1. Start Internet Explorer.

2. Choose Preferences from the Edit menu.

3. Under the Java section of the Preferences dialog box, clear “Restrict Access to 
Non-Java Files.”

You can also change settings for viewing and printing the Job Log.

4. Under the Receiving Files area, select File Helpers and click Add.

5. Configure settings as follows, without adding blank spaces:
XC 701P41810 (EFI Part Number: 45042719)
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• Description: Job Log

• Extension: .log

• MIME type: TEXT

• File type: TEXT

• File creator: TEXT

• For Encoding, select the Plain Text, Use For Incoming, and Use For Outgoing 
options. Leave the remaining options cleared.

• Under Download Destination, choose Download Folder from the menu.

• Under Handling, choose Save To File from the menu.

Clearing the server

When the Fiery EX12 is cleared from Command WorkStation, the connection with 
Command WorkStation is lost. Attempts to reestablish connection to the Fiery EX12 will 
fail. To work around this problem, clear the server from the Control Panel instead. 

Restarting the server

In Brazilian Portuguese, Dutch, French, German, Italian, and Spanish, the warning 
messages for rebooting the server and restarting the server are the same.  

Job Size

Command Workstation 4 displays job size in kilobytes, regardless of the size of the file. 
Other tools may show job size in megabytes or kilobytes.

Enabling animation

By default, animation is set to Off. To enable animation, choose Preferences from the Edit 
menu. In the Preferences dialog box, select Enable Animation.

Using imposition templates

User-created imposition templates created with an older version of Fiery DocBuilder Pro™ 
may not work as intended with the Fiery EX12. The standard templates included with 
older versions of DocBuilder Pro should work properly with the Fiery EX12. 

If you save a job in DocBuilder Pro that uses an imposition template, when you reopen the 
job in DocBuilder Pro, the name of the template you used will not display in the 
Template field. 

Sending print jobs between Fiery servers 

Command WorkStation does not send processed (rasterized) jobs between Fierys. Only the 
non-rasterized portion of the job is sent to the receiving Fiery.

Archiving

Archived jobs do not have actual file names, but have cryptic names recognizable only by 
the Fiery EX12. Archived jobs are intended only to be accessed by the Fiery EX12. 

FreeForm

The number of copies printed does not display in the FreeForm window in 
Command WorkStation. 

Command 
WorkStation
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Override settings

Selecting Command WorkStation override settings may cause a print job to process 
incorrectly. If you override a setting for an option from the Command WorkStation and 
then open the job settings again to replace that setting with Printer’s Default, you may get 
unexpected printing results. To avoid this, do not choose Printer’s Default when you 
override print settings from the Command WorkStation or remove the original raster file 
before you override print settings again.

Cancel Printing

If you choose Cancel Printing from the Server menu on Command WorkStation, and you 
restart the Fiery EX12 before the Cancel function has been completed, you will lose the 
connection to the Fiery EX12 and unknown errors may be displayed. 

Adobe PageMaker job properties 

In PageMaker, the job property for paper source may be displayed as inputSlot instead 
of tray.

Mac OS

When you print a job to the Fiery EX12 from a Mac OS computer, erroneous characters 
may appear in the job name in Command WorkStation queues and on cover sheets.

Uninstall option

The Uninstall option is not available in the Command WorkStation or ColorWise Pro 
Tools program groups. To remove these applications, run the installer again (Setup.exe) or 
use the Add/Remove feature in the Control Panel.

Printing Job Log

To print more than 55 jobs in the Job Log, select the Job Log tab in Command 
WorkStation and select Print from the Window menu. If you select Print Pages from the 
File menu, the Job Log will only print the first 55 jobs. 

Previewing secured PDF files

If you preview a spooled (not RIPed) PDF print job that has Acrobat security set to prevent 
editing, you cannot edit, add, or remove pages from the Preview window. No warning 
message will appear. If you cannot edit a PDF print job, open the file in Acrobat and check 
the security settings. 

Using tray alignment

Tray alignment is not supported for Tray 5. When you use tray alignment for B4 and B5 
paper, you must use JB4 and JB5, rather than ISOB4 and ISOB5. 

Changing page numbers

When you change the page number on a page, the page numbers for nearby pages may 
appear incorrectly. Scroll left or right to refresh the view, and the page numbers will 
display correctly.

Installing PitStop

Enfocus PitStop is provided with DocBuilder Pro for editing PDF files in Adobe Acrobat. 

DocBuilder Pro
XC 701P41810 (EFI Part Number: 45042719)



Page 13
To install Pit Stop, run the pp4(1).61.Setup.us.exe file in the Pit Stop folder on your CD, 
and follow the instructions in the installer program. Once installed, additional Pit Stop 
editing functions will appear in Acrobat. 

Pit Stop is not available in Brazilian Portuguese, Dutch, or Italian.

Using imposition templates

User-created imposition templates created with an older version of DocBuilder Pro may not 
work as intended with the Fiery EX12. The standard templates included with older versions 
of DocBuilder Pro should work properly with the Fiery EX12. 

If the final job has fewer pages than the imposition template used, the job may print with 
extra blank pages at the end of the print job to make up the number of pages originally in 
the template. 

If you save a job in DocBuilder Pro that uses an imposition template, when you reopen the 
job in DocBuilder Pro, the name of the template you used will not display in the 
Template field. 

The following items are not saved in DocBuilder Pro 1.5 templates:

Sheet:

• Size

Layout

• Printer Marks - Horizontal Offset

• Printer Marks - Vertical Offset

• Printer Marks - Pull in to page edge

Scale

• Scale Mode - Custom

• Offset - X and Y

Page Operations:

• Delete Sheets

• Add Sheets

DocBuilder Pro 1.5 templates save only the factory pre-set value for Creep Adjustment. 

Exporting to PPML

When you export a job to PPML, you must save the file in the same folder where the 
elements for the job reside. Otherwise, the PPML job will not be successfully exported with 
all of its elements. 

When exporting a job to PPML, in the ‘Image file formats in this PPML.zip job” 
dialog box, wait for the all the unzipping messages to finish before you click OK. 

Exporting to VPS

The default output name for VPS from PSM is “.ps.” It should be “.vps.” 

Variable data 
printing
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Duplexing PPML jobs

To duplex a PPML job head to head from PSM FV, use the following setting before 
exporting the job: Edit > Preferences > Print Order: Select “Double Sided Layout”.

Otherwise, override job properties settings in Command WorkStation.

Printing a cover page

Cover pages for PPML jobs may print the wrong size for the paper selected. This does not 
affect the rest of the print job. 

PPML, VIPP, VPS features not supported

The Fiery EX12 does not support the following features for PPML, VIPP, and VPS jobs:

• Document Copies

• Imposition

• Print Layout

• URIs

• Streaming

• Package methods other than Zip

• Source element formats other than EPS, PDF, or PS

• Printing to the direct queue

• Preview in the hold queue

• For Fiery WebSpooler and Fiery Spooler, Thumbnail B. Thumbnail A only works 
during RIPping.

• Page range override

• Combine separations

• Optimize PPT

• Remove White PPT background 

Windows/Macintosh support

EFI Hot Folders available through the Fiery Graphic Arts Package run on Windows 
operating systems only. 

Hot folders residing on Windows systems may be shared over an Appletalk network for 
printing jobs from Macintosh clients. To accept jobs over the network from Macintosh 
clients, EFI Hot Folder software must be installed on a Windows NT 4.0 server, with 
Services for Macintosh (SFM) enabled. Once the created folder is shared, Mac users can 
drop files into the shared folder. 

Hot folders running on NT Workstation and other versions of Windows will not accept 
jobs from Macintosh clients.

Formats other than EPS, PDF, and PS

When files other than EPS, PDF, or PS are placed in a HotFolder, they will not print, and 
no error message is displayed. 

HotFolder marking

The HotFolder marking does not always appear on HotFolder icons, depending on which 
version of Internet Explorer you are running. 

Hot Folders
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Keep Original

Avoid setting the Keep Original option to use the HotFolder as the repository. 

Server association

The Hot Folder interface used to find and associate print servers to folders differs slightly 
from other Fiery tools. When a new Hot Folder is added, you need to search for the server 
you want to use for printing.

Passwords

Passwords can be up to 31 characters long. Passwords are case sensitive.

For security, passwords are hidden when you enter them. 

The password is included in a print job as an unencrypted string, which can be intercepted 
with a network sniffer, and viewed by opening the contents of the PostScript file. 

The list of passwords on the Fiery EX12 is not encrypted.

Group names

Group names can be up to 16 characters long.

Incorrect group name or password

If you enter an incorrect group name or password for a print job, the job generates an error 
message and proceeds to the Printed Jobs queue without printing. 

Using other printer drivers

If you do not use the Fiery EX12 printer driver to send the print job, you need to enter the 
group name and password in Command WorkStation or Fiery WebSpooler. 

Job Log fields

The Notes field in the printer driver is stored in the Notes 1 field in the Job Log. The 
Group Name field in the printer driver is stored in the Notes 2 field in the Job Log. 

Output profiles

If you use the output profile Fiery EX12 DocuColor 12 Max PPM K with the rendering 
style Absolute Colorimetric, equal values of red, green, and blue retain CMYK values. 
Jobs will be printed at the copier-rated engine speed for color pages, even if the job contains 
black-only pages.

Serial port appears to be available while in use by the LCD

The Fiery EX12 COM2 serial port is used by the LCD screen by default, yet is still able to 
be selected during the installation of other programs. Multiple selections of this port may 
cause a conflict.

Calibration with a densitometer

You can calibrate the Fiery EX12 with an XRite DTP 32 or 41 densitometer via Client 
Workstation or Server only if you have the Fiery Advanced Controller Interface option 
installed. Otherwise, you must calibrate using the AutoCal™ or ColorCal™ method if you 
are using the copying capabilities. For more information on calibration, see the 
Color Guide.

Printing groups

ColorWise Pro 
Tools
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For Mac support, calibration with a DTP 32 densitometer and the EFI Densitometer 
requires a serial port adapter and USB PDA adapter, respectively. We recommend you use 
the Keyspan adapter if your Mac does not have a serial port.

Associating output profiles and calibration sets

Before you can print a Comparison page or View Measurements, you must associate 
the output profile with the same calibration set you chose when you printed the 
measurement page.

To link a calibration set with an output profile:

1. Start ColorWise Pro Tools and click Profile Manager.

2. Select the Fiery DocuColor 12 output profile and click Edit.

This starts Color Editor.

3. Without making any edits, click Save in the Color Editor window.

4. In the Description field of the Save window, enter a new name for this copy of the output 
profile and click Save again.

5. Give the profile a name that describes what type of job it is optimized for, such as 
SpecialBluePaper.

6. Click Done in Color Editor window.

7. Back in Profile Manager, select the new output profile you just created and click 
Profile Settings.

8. Under Use Calibration Set, select the calibration set you used when you calibrated the Fiery 
EX12 and click OK.

9. Click Done in the Profile Manager window.

Now you are able to print the Comparison Page or View Measurements from the Calibrator 
Expert window. If you have not associated the calibration set with an output profile, an 
error message appears.

Profile Manager

When using Profile Manager from ColorWise Pro Tools on the Fiery server, the default 
color directory is not available upon install. Simply add the color folder as follows 
(D:\\WinNT\system32\Color) and Profile Manager will be able to download and upload 
from the default location as expected.

Monitor Profiles

When you select a monitor profile from the Spot-On® module, the dialog box displays all 
file types. It should show only ICC and ICM monitor profile files. 

Scanning from Adobe PhotoShop

When you scan and print a job from Adobe PhotoShop, the orientation may change from 
portrait to landscape. To print correctly, rotate the job 90 degrees clockwise. 

Fiery Scan
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Scanning while a print job is processing

Do not begin scanning a job while a job is in process. Wait until the current job has finished 
printing before using Fiery Scan.

Corel Draw/TextBridge Pro 9.0/Pagis 3.0

Fiery Scan does not support CorelDRAW, TextBridge Pro 9.0, or Pagis 3.0. 

Match Copy

If you select Match Copy as the color conversion method, some scans may appear pink 
when viewed onscreen. These images will print correctly only if you set the CMYK 
simulation option to Match Copy in the printer driver.

Number of copies printed

The number of copies printed can be incorrect for interrupted jobs. If a multiple copy print 
job is interrupted by a copier error (such as an empty paper tray), in the middle of a copy, 
the Fiery EX12 reports to Velocity that it has finished the current copy. Then, when 
Velocity reroutes the job to another copier/printer, it starts at the next copy after the 
interrupted one. 

For example: If you print 10 copies of a print job through Velocity to the Fiery EX12, and 
the job is interrupted in the middle of Copy 2, Velocity reroutes the job to another 
copier/printer, starting at Copy 3. 

EFI Converter 1.0 

EFI Converter 1.0 is only available in English, and is supported on all Windows versions 
except Windows 95.

All

If a finishing option such as Collating or Stapling is available and selected within the 
application or printer driver, unexpected results may occur. To avoid this problem, do not 
select the option within the application—select it within the Fiery EX12 PPD.

Long Edge Feed paper sizes differ slightly from corresponding Short Edge Feed paper sizes 
in the print properties within applications. For example A5 (LEF) appears as 5.833 x 8.264, 
while A5 SEF appears as 5.833 x 8.278. These size discrepancies are negligible and do not 
affect the printing result. 

When configuring Installable Options in the printer driver for Windows NT, the Add and 
Remove buttons are unavailable. Scroll to the Installable Options under the Device Settings 
tab to configure the Installable Options.

Microsoft Office

Pattern—When printing pattern fills from Microsoft applications, scaling/resizing them 
could cause unexpected color changes, especially if the fill is placed into another 
application. To avoid this problem, use solid fills rather than pattern fills.

Microsoft Word 97—In Microsoft Word 97 on Windows 95/98, when you print jobs of 
more than 1,000 pages in reverse order, the first 1,000 pages are RIPped and printed before 
the remaining pages are RIPped and printed. 

In Microsoft Word 97 on Windows NT 4.0, when you print jobs with Pure Black Text and 
Graphics set to Off, the job is printed with black-only text. 

Velocity 
compliance

EFI Converter

Applications
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Gray objects identified in Job Log—Gray objects in a print job from a Microsoft Office 
application will appear as a color print in the Job Log. To make sure the job appears as a 
black-and-white (B&W) job in the Job Log, use the Fiery EX12 DocuColor 12 HiGCR 
output profile.

Microsoft Excel

Printing Workbooks—If you choose Entire Workbook in the Print dialog box from 
Microsoft Excel for Windows, the job may print as separate jobs, because Excel sends each 
worksheet to the copier as a separate job. Print settings such as Duplex and Sorter Mode 
will be applied to the first worksheet and ignored for the rest. To apply print settings, you 
must select each sheet, go to Page Setup/Options, and select the print option settings for 
your job. To print the Entire Workbook, select all sheets in the workbook. Click the first 
worksheet tab at the bottom of the Excel page, hold down the Shift key, and click the last 
worksheet tab. Select Print from the File menu. In the Print area of the Print dialog box, 
select Active Sheets, and the job will print correctly.

Multiple copies—If you select a number larger than one for the Number of Copies option 
in Microsoft Excel 97 and the Collate check box is also selected, Excel will send multiple, 
identical jobs to the Fiery EX12. You must clear the Collate check box before you send 
multiple copies from Excel.

Microsoft PowerPoint

Copies—When you select the number of copies in the Adobe driver, the driver will not 
update the number of copies in the application you are running. In order to print the 
requested copies, make sure you enter the number of copies in the application’s Print dialog 
box and in the Adobe printer driver.

QuarkXPress

Duotones—Use duotone EPS files created in Adobe PhotoShop 5.1 for printing. Files saved 
in Adobe PhotoShop 5.0 may print with incorrect colors when opened and printed 
in QuarkXPress. 

Page size—The Page size option in QuarkXPress defaults to Custom for the Fiery EX12 
PPD. If you do not want to print your job on a Custom page size, you must select another 
page size before printing.

Windows version—The N-Up, Watermark, Mirror Image, and Negative Image options do 
not function in QuarkXPress for Windows.

Pure Black Text and Graphics—If you turn Pure Black Text and Graphics On in 
QuarkXpress, the file may print incorrectly. Make sure Pure Black Text and Graphics
is turned Off for blends created in vector-based programs.

Black Images Imported from Adobe Photoshop—When you import a 100% black EPS 
image created in Adobe Photoshop to QuarkXPress 4.1, the color will be a lighter black 
shade. To achieve 100% black text and graphics, turn off Pure Black Text and Graphics.

Novell banner page—If you experience a paper jam when you print with a Novell banner 
page, turn off the banner page.
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Tray Alignment—If Tray Alignment does not work with Quark registration marks, use a 
larger paper size so the registration marks fit correctly. For example, print Letter size paper 
on Tabloid.

Printer Description files—QuarkXpress will not automatically find the printer description 
files on Windows 2000. To find the file location, use the printer description file manager 
found under the Utilities menu.

Adobe PageMaker

Printer’s Default—Do not choose Printer’s Default when printing from PageMaker. 
PageMaker does not recognize the Printer’s Default information in the Fiery EX12 PPD. 
Selecting Printer’s Default in PageMaker may cause unexpected printing results. 

Duplex—All jobs sent from PageMaker will be sent with Duplex On, even if you specify 
Duplex Off in the print option settings.

When specifying duplex with the N-up feature, the job will not print out correctly. 
The opposite of what is selected will print. 

Printer description files—Pagemaker 6.5 does not support automatic installation of printer 
description files from the Printers Control Panel. 

To make the Fiery EX12 available in the Print and Page Setup dialog boxes of this 
application for all Windows computers, copy only the Windows NT 4.0 printer description 
file to the appropriate location. The NT driver is the only version that can support upper 
ASCII characters for foreign languages with Pagemaker 6.5.

Perform the following steps:

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. 

2. Select English\Prntdrvr\Ps_drvr\Win_NT4x.

3. Copy the printer description file for your Fiery EX12 to the 
\PM65\RSRC\USENGLSH\PPD4 folder on your operating system. 

Job properties—In PageMaker, the job property for paper source always displays 
“InputSlot”. 

Edit and print problems—Some documents edited and printed in PageMaker on Windows 
2000 crash the EX12 print driver, producing the following error message: “PM65.exe has 
generated errors and will be closed by Windows. You will need to restart the program.” 
We recommend that you save documents after editing and prior to printing, or restart the 
application prior to sending edited documents to print. 

When printing files in PageMaker to the EX12, select the EX12 PPD in the Page Setup and 
Print dialog boxes before changing any other print properties. Changes to page size and 
other settings before selecting the PPD may cause PageMaker to close without printing.

CorelDRAW

Printing from Mac OS—You need to set the same print options, such as number of sets and 
collation, in both the application and the Fiery EX12 printer driver. 

Scaling—When you select scaling in CorelDRAW on Windows 2000, Windows NT, and 
Windows Me, the job may shift towards the upper-right corner.
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Negative Images—CorelDRAW 8.0 does not support negative images.

Corel Word Perfect

Print jobs sent from Corel Word Perfect may not print correctly.

Collate—The Collate option is not supported and must not be selected.

Staple—Stapling does not work when printing a Word Perfect 2000 document.

Freehand

Windows version—The N-Up option does not function in Freehand 8.0 for Windows 98.

Mac version—Make sure to select the “Use ppd” check box in the Print dialog box for 
Freehand 8.0 or later, in order to use the printer driver and selected print options.

N-up—The N-up option does not work when printing from Freehand.

Editing device settings

In order to change print defaults in a driver that was downloaded from the Fiery EX12 
using WINS printing (SMB), the permissions for the Print queue on the Fiery EX12 server 
must be set to Full Control for the user “Everyone.” Once you are logged in with 
Administrator privileges, you can allow a user, or all users, the ability to change print 
defaults in the driver by enabling Full Control in the Properties > Security > Permission tab. 

Sending jobs via AppleTalk

When sending a print job from a Windows NT client computer using AppleTalk, the user 
identification will display as “Unknown.”  

Connecting to other NT servers with Point and Print

Using Point and Print (PnP), you can download printer drivers from any printer server in 
your network. If you use PnP to connect to an NT server that has guest logon disabled and 
has a different Admin logon than your client, you will get a connection error. To avoid this, 
log on to the NT server in Windows Explorer to establish the connection before connecting 
to it with PnP.

PnP is not supported on systems running NT 4.0 with Service Pack 6A and security hot 
fixes installed.

Windows XP Support

Windows XP is supported for the Fiery EX12.

Using Microsoft Office 2000 applications

When running a Microsoft Office 2000 application, you may see an error message stating: 
“Microsoft Word/This file Contains macros with an expired or revoked signature. Since you 
are running under High Security Level, These macros disabled.” Clicking OK in the error 
dialog box returns you to the application. The message is caused by a digital signature for 
Adobe Acrobat 4.05 that has expired. 

To avoid this error message in the future, change the Security settings in the Office 2000 
application that returns the error:

1. In the Office 2000 application, choose Tools > Macro > Security.

Setting 
print options

Windows NT

Windows XP 
Professional
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2. In the Security dialog box, click the Security Level tab, and select the desired 
security level.

3. Click the Trusted Sources tab, and select “Trust all installed add-ins and templates.”

4. Click OK to save your changes.

5. Restart the Office 2000 application. 

Job Title/User Name

The Job Title/User Name does not display for Standard TCP/IP for Windows 2000.

Point and Print

Point and Print driver installation is not supported under Windows 2000. Use the WebTool 
Installer or the User Software CD to install drivers and create the SMB printer port.

Custom page sizes

You can only print custom page sizes from Windows 2000 if you send the job from a 
Microsoft Office 2000 (or later) application. From the application, specify the custom page 
size in the print properties. In addition, choose PostScript Custom from the Scale to Paper 
Size menu in the Print dialog box, and then click Print. 

TCP/IP and DHCP servers

In some cases, Mac OS computers may crash when attempting to obtain an IP address from 
a DHCP server while loading the TCP/IP driver. Check the TCP/IP control panel to make 
sure you are using a valid IP address and that the router and DNS server addresses are valid 
before running applications such as ColorWise Pro Tools.

Graphic Arts Package

Mac X Classic does not support the Graphic Arts Package (GA) Hot folder and TIFF/IT 
converter features.

Spot-On

On Mac OS computers, uploaded groups from Spot-On are not associated as ColorSync 
profiles. To associate an uploaded group as a ColorSync profile, open the uploaded file in a 
resource editor such as Filebuddy or ResEdit and change the Type field to “prof” and the 
Creator field to “sync”. 

Print Mode

Occasionally, the copier remains in Print Mode when you attempt to make a copy. 
Check the copier timeout values in Tools and optimize as necessary. 

A6 paper size

When you specify A6 as the paper size for a job and send the job to print, the copier will 
display a message instructing you to load the paper using Short Edge Feed orientation. The 
copier only accepts A6 paper when it is loaded using Short Edge Feed. 

Copier messages on the Command WorkStation

Occasionally, messages from the copier may vary when displayed on the Command 
WorkStation. Check the message on the copier display if you suspect a discrepancy. 
However, if the finisher is installed on the copier, see the error message displayed on the 
Fiery EX12 Control Panel or Command WorkStation.

Windows 2000

Mac OS

Copier
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Finisher/Stacker installed

The following situations can result when you press the Finisher Pause button on the 
DocuColor 12:

Stapled job—The Fiery completes printing the job and “Finisher paused” appears on the 
Fiery EX12 Control Panel.

Non-stapled job—The Fiery EX12 stops printing the job and “Finisher paused” appears on 
the Fiery EX12 Control Panel.

Suspend Printing selected from the Command WorkStation/Control Panel/WebTools—The 
Fiery EX12 displays “copier offline.”

Resume Printing selected from the Command WorkStation/Control Panel/WebTools—The 
Fiery EX12 displays “Finisher paused.”

Copier interrupt key is pressed on the DocuColor 12 (stapled job)—The Fiery prints the 
entire job; when the job is complete, “copier busy” appears on the Control Panel.

Copier interrupt key is pressed on the DocuColor 12 (non-stapled job)—The Fiery EX12 
displays “Finisher paused” on the Control Panel and ignores the copier interrupt command.

When you print to the Direct connection, pressing the Interrupt button on the copier may 
not work properly.

Specifying installed options for the copier via SMB printing

When you set up the Fiery EX12 for SMB printing, you can also specify installed options, 
such as the Finisher and Tray 6. For systems with the Fiery Advanced Controller Interface, 
you can specify these options directly from the Fiery EX12. 

For systems without the Fiery Advanced Controller Interface, you must use a networked 
Windows NT 4.0 computer, as described in the following procedure:

1. Log in as Administrator to a Windows NT 4.0 computer in the same domain as the 
Fiery EX12.

2. Locate the Fiery EX12 in Network Neighborhood, and double-click it.

3. Right-click a print connection (Direct, Hold, or Print), and choose Properties.

4. Add the appropriate installed options.

5. Repeat the previous two steps for the other print connections.

Graphic inconsistent

The picture of the Fiery VDP resource manager on page 5-14 of the Printing Guide is not 
the same as the picture on page 7 of the User Addendum, or page 2-12 of User Software 
Installation, which use a picture of the resource manager as it appears in Windows 2000 and 
Mac OS 9.1.

Documentation
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